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1 Introduction 
Mirasys Spotter is a modern, easy-to-use application for viewing live and recorded video and 
exporting video clips. 

Mirasys Spotter can be used to create multi-monitor configurations with multiple independently 
operating device tabs and windows. 

A spotter can also be used to connect to multiple different VMS Servers simultaneously. 
Spotter supports camera tours, alarms, audio, I/O feeds, text channels, the opening of video 
archives and clips, as well as layouts for storing and accessing desired configurations. 

A spotter is expandable with various plug-ins like Mirasys Video Wall (MVW) video matrix option 
(add-on). 
This feature's availability depends on the VMS type you have purchased (Base, Pro or 
Enterprise). 
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2 Starting Spotter and Logging In 
Spotter is started by double-clicking the Spotter icon on the desktop is also possible to start 
Spotter automatically when the computer boots up. 
It is possible to create shortcuts that control to which Master Server Spotter connects. The 
application launcher dialogue for site selection can be accessed by pressing the "Delete" button 
on the initial dialogue when the spotter is launched as administrator. 

 

 
 

The site selection list contains the list of all the master servers that have been configured. More 
servers can be added, or the details of existing servers can be edited with the add and edit 
options. Users can choose a server and press "Continue" to log in to that server.  

 
The system will log in to the last server if the site selection screen is not accessed during 
Spotter’s startup. It is possible to log in to different versions and servers that are 32-bit or 64-bit 
versions. The settings and other site-specific information and resources for different servers are 
stored separately. After choosing a server and continuing, the login screen is shown (unless the 
user has selected automatic login for this server). 

 
The user can enter his/her username and password here and then "Continue" to log in. It is 
possible to have multiple Spotter windows logged in to different servers simultaneously. After 
logging in to one server, the user can re-start Spotter from the desktop icon, enter the site 
selection dialogue and select another site. All site-specific operations such as layout saving only 
affect the Spotter settings to which the user is logged. 

2.1 Postpone Spotter restart 
When the system is updated, and there comes an event that the client needs to be restarted, if 
postpone Spotter restart is set on Spotter user roles, then the client restart is postponed. 
Postponing time is defined in the Spotter user role. Postpone time and the possibility to trigger 
Spotter restart are shown in Spotter UI. 
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3 Changing the Spotter language 
1. Click File\Settings 

 
 

2. Select a correct language from the drop-down list 

 
 

3. Click Save 
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4 Spotter UI 
Here you can see an overview of the different Spotter user interface components. 

 

4.1 Spotter Title Menu 

4.1.1 File 

4.1.1.1 Various functions can be accessed from the File menu.  

4.1.1.1.1 New Window 
New Windows opens independent Spotter Window, which can be dragged for example to 
another monitor. 

4.1.1.1.2 New tab 
A new tab creat a new device tab in the work area. 

4.1.1.1.3 Create Archive 
See more from Create Archive 

4.1.1.1.4 Open Media 
The opening created archive or media clip 

4.1.1.1.5 Settings 
See more from Settings 

4.1.1.1.6 Lock 
The user can manually lock and log off Spotter from the File menu. 

4.1.1.1.7 Log off 
Using Log off, users can end the Spotter session and go back to the login screen. 
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4.1.1.1.8 Switch user 

 
Switch user option allows change logged users without logoff. 

When the Switch user is selected, the current user is shown. 

1. Enter a new username and password 

2. Click Continue 

As default new user´s layout is loaded 

 

4.1.1.1.9 Exit 
• With the Exit, the user can close the Spotter application 

4.1.1.2 Alarms 
See more from Alarm Management 

4.1.1.3 Search 
See more from Search Tools 

4.1.1.4 Devices 

4.1.1.4.1 Input devices 
You can use any DirectX compatible joystick as a control device. 
A joystick can be fully configured, and each button can be assigned a customizable function. 
Before a joystick can be taken into use, it needs to be configured, first in Windows, then in 
Spotter. 
To calibrate a joystick in Windows, open the Control Panel and find “Set up USB game 
controllers” under “Devices and printers”. 

Follow the instructions on calibrating the joystick. 

4.1.2 Adding Input devices  
1. Start Spotter 

2. Go to Devices and open Input devices 

 
 

1. If the “Setup” line item is not visible, add it using the “+ Add” button. 
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1. Define the Setup name 

2. Start configuring the buttons by clicking Click to edit 

 
 

1. Select functions from the list 

2. Click Press the device button or use the joystick 

 
 

1. Press the select button until the value reaches 100% and the release button 
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1. When the button is correctly initialized, the clear button appears at the end of the line 

2. Repeat the actions and finalize by clicking Save and close 

 
 

4.1.2.1 Profiles 
Profiles contain all profiles, which has been added to the user group 

4.1.2.2 Layouts 

4.1.2.3 View 

4.1.2.3.1 View-tab contains view options for: 
• Zoom 

• Edit Custom grids 

• Playback 

• Timeline 

• Device tree 

• Description 

• Alarms 

• Storyboard 

• Tabs 

• Auto Hide 

4.1.2.4 Plugins 
See more from Plugins 
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4.1.2.5 Help 
Spotter contains built-in help. The help is accessible from the Help menu or by pressing the F1 
key.  

 
Help contains information on new features and valuable things like keyboard shortcuts and links 
to view training videos. 

4.2 Spotter Device Tree 
The Device tree title shows the name of the Master Server that Spotter is connected to. 
Below is a search field that can be used to filter the tree contents. 
Any text entered in the area can be removed with the "X" control or by pressing the Esc-key. 
This also clears all profile folder searches. 

 
 

The Device tree contains five different types of content that can be opened to the work area. 

4.2.1 Profile 
The currently selected profile, which includes the cameras and other devices, is the first item. 
The shape can be changed from the title menu. 
Each profile folder can be searched independently using profile folder search.  

4.2.2 Layouts 
Contain all the available layouts for the current user if configured. 

4.2.3 Plugins 
Contains all plugins, which are enabled in the master server license 

4.2.4 Bookmarks 
Contains all specific user saved  and shared bookmarks 

4.2.5 Saved tabs 
Contains all tabs, that the user has saved. 

4.2.6 Device states 
When the device is in another state, for example, no signal, connecting, and connection, there 
is an icon on top of the device symbol. 
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4.2.7 Alarms 
If a device is used as a trigger or an alarm action in an active alarm, it has a yellow highlight 
colour. 
The colours for active and ended alarms can be adjusted in the Alarm Visualization Settings 
Alarms can also be assigned a custom colour that can be specified for each alarm separately. 

4.2.8 Device name and descriptions 
The name and description are visible in the device tooltip—unique icons for the System 
Manager Profile Settings devices. 

 
 

4.2.9 Frequently Used Keyboard Shortcuts: 
Shortcut Description 

Ctrl+Alt+D Cycle between the different device tree view modes 

4.3 Spotter Device Numbering 
The shortcut numbers for cameras are assigned via the system manager at the profile level. 
The configured keyboard shortcuts can be accessed anywhere in Spotter by using the numeric 
keypad. 
The entered numbers show up in a popup dialogue. 

 
The dialogue can be positioned anywhere in the Spotter window, and it will remember the set 
location. 

When the following Numpad keys follow the numbers: 
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• Enter: The camera is opened. 

• Double-Enter: The camera is opened and maximized, and if a PTZ camera, the PTZ 
control is assumed. 

• “+”: Spotter window is selected. 

• “-“: the camera is closed. 

• “/”: layout is loaded. 

• “,”: saved tab is loaded. 

The device numbering settings can be exported and imported to another PC. The import works 
only if the same profile is active. 

4.4 Spotter Work Area 
The work area is the region of the Spotter window where the content of the devices can be 
viewed. 
When cameras and other devices are added to the work area, they automatically open the 
stream to the playback position or the live position of the work area.  

 

4.5 Spotter Playback panel 

 
With the playback buttons, the user can choose the direction and speed of the playback. 
With each mouse click, the speed can be increased (left click) or decreased (right-click). 
The speed is indicated with a small number on the button. 

 
Very low speeds 1fps, 0.1x, 1/8x, 1/4x and 1/2x are accessible only with the slider or by clicking 
with mouse right button on the playback button to reduce the speed. 

 
If the user wants to go to real-time mode, there is a "Go to current time" button. 
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4.5.1 Playback panel controls 
Using the small arrow to the right of the playback panel, the user can configure which controls 
are displayed in the two available view modes for the playback panel. 

 

4.5.1.1 Playback panel state 
• Show normal  

• Hide 

• Show minimized 

4.5.1.2 Controls in large playback panel 
• Date picker 

• Time picker 

• Activity selection 

• Step buttons 

• Playback speed slider 

• Quick bookmark button 

• Camera tour controls 

• Tab step / next camera tour step buttons 

4.5.1.3 Controls in small playback panel 
• Date picker 

• Time picker 

• Activity selection 

• Step buttons 

• Quick bookmark button 

• Camera tour controls 

• Tab step / next camera tour step buttons 

The only control that is not available in minor view mode is the Speed slider.  
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4.5.2 Date And Time Controls 

 
 The date and time controls show the selected date and time. 

The user can change the date by opening the calendar.  

 
The buttons left and the date adds or subtracts one day from the currently shown day. 
It is also possible to click on the date box and enter the date manually. 
The buttons left and right of the time add or subtract one hour. 
Like with the date selector, it is possible to click on the time box and manually enter the time 
box. 

 
It is also possible to quickly set time with 10-minute accuracy using the pulldown menu. 

 

4.5.3 Frequently Used Keyboard Shortcuts: 
Shortcut Description 

Ctrl+Right Set playback time +30 seconds. 

Ctrl+Left Set playback time -30 seconds. If in real-time mode, switch to playback mode first, 
and set 1x speed. 

Ctrl+Space Pause playback. 

Ctrl+Enter Go to real-time. 

Ctrl+Alt+C Cycle between different view modes. 
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5 Real-time mode 

 

5.1 Opening single camera or device 

• Double click camera from device tree 

• Drag camera from device tree to the work area 

5.2 Opening device group 

• Double click device group from device tree 

• Drag device group from device tree to the work area 

 
 

The camera name and timestamp are shown on the top left corner of the camera.  
The visibility and colour of the name and the timestamp can be controlled from 
Spotter\File\Settings\Display or the Camera toolbar\Settings\Display  
The camera recording indicator is a small blue dot next to the timestamp.  
It is displayed when the camera is recording. 

5.3 Virtual Cameras 
1. Open camera to the real-time view 

2. Open camera toolbar 

3. Select Camera 

4. Select Duplicate 
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1. Open View 

2. Select Move/Zoom 

 
 

Mouse wheel movements will make the virtual camera rectangle larger or smaller. 

The size can also be adjusted by dragging the edge of the rectangle with mouse and left-click. 

The size will also change from the keyboard "page up" and "page down" buttons. 

1. Draw zoomed area 

2. Click OK 

 
 

Create more virtual cameras, if needed 
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5.3.1 Frequently Used Keyboard Shortcuts: 
NOTE: Only when in virtual camera editing mode. 

Shortcut Description 

Arrow left Moves the red box to the left. 

Arrow right Moves the red box to the right. 

Arrow up Moves the red box up. 

Arrow down Moves the red box down. 

Page Up It makes the box more significant (zoom out). 

Page Down It makes the box smaller (zoom in). 

5.4 Camera Tour Controls 
Camera tour controls can be configured to be seen in both standard and large view mode 
playback panels. 

 
 

Control is enabled when there is more than one tab open in Spotter. 
Settings are opened from the "Cogwheel" icon. 
There is a row for each tab. Particular tabs like plugin tabs have disabled functionalities and are 
by default disabled. 

 
After each tab, there is an option to enable or disable the tab. All tabs can be added to a tour if 
desired. 
There are two options for the Tour. 
The user can either show cameras simultaneously or show cameras one by one. 
If devices are shown one by one, it is possible to have a tour with just one tab. 
The tour time can be selected at the last row individually, or the user can set a default time and 
define it at the lower-left corner. 
There is also an option to run the camera tour in maximized window state on the lower-left 
corner. This checkbox is selected by default. 

 
When the tour is running, it is indicated with a rotating orange arrow. The Camera borders are 
also highlighted in orange. 
There is also a counter underneath the controls that counts the time set for each tour step. 
The user can also select the forward and backward arrows to move between tour steps. 
The tour is stopped if the user selects another operation in Spotter. For example, the image or 
clip export stops the tour. 
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Note: A camera tour can also be operated in the Agile Video Matrix (AVM) with the AVM 
Operator Console. In AVM, the counter is not displayed.  

5.4.1 Frequently Used Keyboard Shortcuts: 
Shortcut Description 

F12 The toggle camera tour starts and pauses state. 

Ctrl + F12 Steps to next camera tour view. 

5.5 Full-Screen Mode 
A single-camera can be maximized to cover the whole work area with the maximize control or 
double-clicking it. 
The whole work area of a Spotter window can be made to be full screen by pressing the F11 
key or double-clicking the tab control. 
The second press of the F11 key (or the Esc key or mouse right double click) will return to the 
original window size. 

5.5.1 Frequently Used Keyboard Shortcuts: 
Shortcut Description 

F11 Maximize the current tab to full-screen size. 

F11 or Esc Restore maximized tab to average size (when no camera is selected). 

5.5.2 A single camera on the device tab 
A single camera can be maximized to cover the whole work area with the 
mouse RIGHT double-clicking it. 
The second mouse RIGHT double-click returns the original size. 
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5.5.3 Multiple cameras on the device tab 

5.5.3.1 A single-camera full-screen 
A single camera can be maximized to cover the whole work area with the mouse LEFT double-
clicking it.The second mouse LEFT double-click returns a single camera to the original size. 

5.5.3.2 Device tab full-screen 
A whole device tab can be maximized to cover the whole work area with the 
mouse RIGHT double-clicking it.The second mouse RIGHT double-click returns the device 
tab to the original size. 

5.6 Camera Toolbar 

 
The camera toolbar is displayed when the mouse is moved over a camera or if a camera is 
selected with other means.If the mouse is not moved for some time, the camera toolbar 
disappears automatically. 

5.6.1 The camera toolbar can contain the following items: 
• Settings 

• Export 

• Print 

• Camera 

o Dome control, duplicate modes 

• 360 camera de-warping 

• Two-way audio 

• Image controls 

• Highlight 

• View or virtual zoom 

5.6.2 Spotter Camera Settings 
All the camera-specific settings are saved to layouts when a user saves a layout.See 
the Layouts of this guide for further information. 
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The camera settings contain the camera-specific settings for:  

 

5.6.2.1 Streaming 

5.6.2.1.1 Multistreaming  
• Spotter chooses the recording stream automatically (default) 

• Use Viewing stream if it is configured for the camera 

• Use Streaming stream if it is configured for the camera 

• Use recording streams always 

5.6.2.1.2 Update image 
• Continuously, which draws all images from the camera even when there is no motion 

detected 

• When motion is detected(image is updated only when VMS has detected motion) 

• When motion is detected, minimum interval(min. 1 second and max 60 seconds). 

Below the image update settings is a button to update the current image update settings for all 
cameras on this tab.  

When a new camera is opened to the work area, the image update settings default to the 
setting defined in Spotter\File\Settings\Streaming. 

5.6.2.1.3 The TruCast 
• Always from the VMS server 

• Stream from VMS server if connected, otherwise, stream from the camera 

• Continuously stream from the camera 

The TruCast settings are remembered for the camera, so even if the camera is closed, the next 
time it is opened, it will be using the same TruCast settings last time. 

5.6.2.2 Display 
The display settings control if the name and timestamp are shown on top of the camera and the 
colour used for the text and the text outline.If the user finds a nice colour that he prefers, he can 
set a new global default for all cameras. 
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5.6.3 Spotter Export (Spotter Export Chapter) 
See more under Export image  
See more under Add to video export 
See more from Add to storyboard 

5.6.4 Print 
1. Open camera toolbar 

2. Click Print 

 
 

1. Select the printer 

2. Click OK 

 
 

5.6.5 Two-Way Audio 
If the camera has two-way audio configured, the menu item becomes active. Two-way audio 
can be in three different modes.  
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In the closed mode, the audio channels are not open. In the listening mode, the user will hear 
audio from the camera and any potential audio going to the camera from any other VMS client.  
The audio channel from the current user is not open. In the talk mode, the user can hear the 
audio from the camera, and the audio channel from the current user is open, so the audio is 
broadcasted to the camera. The toolbar icon has red (to camera) and green (from camera) 
volume indicators, which show if there is audio going to or coming from the camera. The 
channel volumes can be adjusted from the sliders. 

5.6.6 Camera 

 

5.6.6.1 Duplicate 
See more information from Virtual Cameras 

5.6.6.2 Duplicate to mixed mode 
The Mixed Playback Mode allows users to review playback on specific cameras while 
monitoring real-time situations in other cameras and doing this while staying in the same 
Spotter tab.The mode is accessed by pressing the Ctrl key and then selecting cameras 
currently open on the Spotter screen with a mouse left-click.The selected cameras will then be 
highlighted with a thick green border.The user can select multiple cameras by keeping the Ctrl 
key pressed and continuing to select other cameras.The selection is cancelled by clicking 
somewhere without keeping the Ctrl key pressed.  

 
When some number of cameras are highlighted like this, they are in mixed playback 
mode.Other cameras that are not selected are always in real-time.The cameras in mixed 
playback can now be controlled with the time slider balloon, the playback controls, or a joystick 
jog-wheel. 

5.6.6.3 Toggle mixed mode 
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5.6.7 Spotter Privacy 
If you have been assigned sufficient permissions, you will also access the "Privacy" menu.  
In here, you may be given access to turn on/off the privacy zones (if you have sufficient 
permissions to do this and the functionality has been enabled for the specific cameras). 

 
Figure 1 Examples of facial blurring- and privacy masks that could be disabled from the 
privacy menu. 
 

5.6.8 Image Controls 

 
The Image Control plugin has various options to adjust the camera image: 

• Option to turn the image into a black and white image 

• Invert colours filter 

• Edge highlight filter 

• Histogram filter (a form of contrast optimization filter) 

• Noise reduction filter 

• Image sharpening filter 

• Image flip (flips the image along the horizontal axis) 

• Image mirror (mirrors the image along the vertical axis) 

• Brightness adjustment slider 

• Contrast adjustment slider 

5.6.9 Highlight 
The metadata objects for LPR and FR events contain bounding box elements and labels 
(identity name in FR metadata and license plate number in case of LPR metadata). These 
bounding boxes and labels can be displayed in the Spotter application if the VCA visualization 
plugin is enabled and the user selects to show VCA in the video view control panel. 
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5.6.9.1 VCA visualization requirements 
Spotter needs to get metadata to visualize objects. 

• The license must have VCA channels. 

• VCA must be enabled for the camera in System Manager settings or license plate 
recognition or face recognition needs to be used 

• The database must be installed (for metadata playback) 

• For best results, hermeneutic motion detection should be used 

• Both VCA Core and Mirasys metadata can be used, although there can be some 
differences in how objects are detected 

5.6.9.2 Visualization 
• Highlight moving objects such as cars and walking persons  

• Show the track that the object has taken on the camera screen  

• Show textual info shows textual info related to the tracked object 

• Show VCA zones and lines after they have been configured using the VCA configurator 

• Show a client-only VCA event counter 

• Reset all counters on a camera screen 

• VCA visualization can be set on for all cameras from the tab menu 

• VCA visualization states are kept in memory and stored on a local PC for each user 

o camera VCA state is remembered so that when the camera is opened, its VCA 
states are set to ones that were used before 

• VCA visualization can be set on / off also with AVM 

The client-only VCA counters are local to the Spotter application and not integrated into the 
Mirasys Reporting+ application.They are meant for short term reporting and can be reset by 
clicking on the counter on the camera screen. 

5.6.9.2.1 Smart recognition metadata visualization 
There are two “Highlight“ menu items for the “license plate” and “face” moving objects 
visualization (drawing borders and name/license plate number): 

• Show license plates 

• Show faces 

 
Figure 2 Smart recognition visualization items 
 

The menu items are enabled only when the camera is configured for any VCA detection. 
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5.6.9.2.2 Settings for VCA visualization in Spotter 
• The line color can be changed 

• Line thickness can be changed 

• Trail maximum length can be changed 

• The zone color can be changed 

5.6.9.2.3 Advanced settings 
In advanced settings, there is a setting to allow VCA for all cameras, even if the VCA is not 
configured for the camera. This is useful in cases where metadata is received from 3rd party 
system (for example, from data drivers) that will not use recorder VCA. 

5.6.10 View 

5.6.10.1 Move / zoom 

 
 Read more about Move / Zoom from Virtual Cameras and Spotter Digital Zoom. 

5.6.10.2 Reset 
Reset to the full image 

 

5.6.10.3 Auto crop 
Enables Auto image cropping to the image 
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5.6.10.4 Follow motion on the whole image area 
Before Follow motion on the whole image area can be used, VCA feature Motion data must 
be enabled from the VCA features tab. 

 
When Follow motion on the whole image area is enabled, then Spotter automatically follows 
motion in the camera area. 

 

5.6.10.5 Follow motion on the zoomed area 
Before Follow motion on the zoomed area can be used, VCA feature Motion data must be 
enabled from the VCA features tab. 
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When Follow motion on the zoomed area is enabled, then Spotter automatically follows 
motion in that area of the image, which has been set to the zoomed state. 

 

5.6.11 Spotter Digital Zoom 
In the camera view, it is possible to digitally zoom a selected rectangle of it or zoom in on it. The 
selected rectangle can open as its view. 

5.6.11.1 Digital zoom with mouse 

5.6.11.1.1 Area zoom (shift key + mouse left button) 
Pressing the shift key and the mouse left button, a sizeable rectangle appears in the mouse 
position. Keeping the mouse’s left button down can change the rectangle area size. If the shift 
key is pressed when releasing the left mouse button, the rectangle area is zoomed to view size. 
Zoomed view returns to normal side either clicking the mouse right button or selecting the Reset 
button from View drop-down button. 

5.6.11.1.2 Zoom in (mouse right button + mouse scroll) 
Pressing the mouse’s right button down over a view, a zoom cross appears over the view. The 
zoomed area can be changed by moving the mouse when the mouse right button is pressed. 
Mouse scroll can then be used for zooming in and out when the mouse button is pressed. The 
current zoomed view stays in view when releasing the mouse’s right button. When pressing the 
right button again, zooming can continue. Mouse the right button click overview, and return the 
view to normal size. 

5.6.11.2 Digital zoom with View drop-down button 

 
 

• Move / Zoom 

o Opens sizeable rectangle overview. Rectangle size and position can change. 
On the view right bottom corner buttons open the selected rectangle as a new 
view (New), zoom the rectangle area in this view (OK), or cancel zooming 
(Cancel). Selected new zoom views can see as dashed line rectangles on the 
original view. 

• Reset 

o Resets view zooming to original size. Same as the mouse’s right button press 
over the view. 

• Auto crop 

o Set/reset auto crop for this view 

• Follow motion on the whole image area, enabled only if VCA is configured to this 
camera. 
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• Follow motion on the zoomed area, enabled only if VCA is configured to this camera. 

5.7 Spotter Text channels 
When the text channel is opened, the below information is shown: 

• Text channel name 

• Time of the event 

• Event name 

 
 

5.8 Audio channels 
Audio channels have a little blue note symbol indicating that the channel is open.The channel 
opens automatically if it is added to the component panel.Audio channels have a similar pull-
down control as outputs to control mute, unmute and volume. 

 
All component panel components, inputs, outputs and audios can be closed from the individual 
component close controls. 

 
The whole component panel can be closed from the component panel close control.When the 
devices are on the grid cell, they can be closed via the usual way with the top right corner "X" 
control. 
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5.9 Spotter Digital I/O 
The component panel width can be adjusted, and it can also be collapsed only to show the I/O 
control.When the I/O devices are added to the camera grid cell, they take over the entire grid 
cell. 

 

 
Outputs have a small pull-down menu that allows control of state switch, pulse and pulse 
duration. 

 
Please note that output states can also be toggled from the device tree by clicking on the output 
control.The default action of the outputs is defined in the System Manager – Profiles section. 
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6 Playback mode 
When the playback mode is used, Spotter shows always latest recorded time from those 
cameras, which the user has selected to the view 

 

6.1 Start instant playback 
1. Select camera or cameras from the device tree(double-click or drag to the work area) 

2. Click the Play backwards button 

3. Change playback speed with the mouse button 
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6.1.1 For users required to add a comment before playback mode 
When a Playback audit comment is required, then in real-time mode, the StepBackward and 
StepForward buttons are disabled. 

When a user adds a comment and moves to playback mode, the buttons are enabled again. 

When loading a layout with streams in playback mode, a comment needs to be added by the 
user before the layout is loaded. 

 

6.2 Playback selected time 
1. Select camera or cameras from the device tree(double-click or drag to the work area) 

2. Use Select date or Select time to go to the needed time 

3. Use the playback controls for the playback 

 
 

6.3 Spotter camera grid selection button 
Spotter playback panel UI has a popup button to open the camera grid selection list. 

 
This button is visible if both following rules are filled: 

The "Change tab grid" setting is enabled in user group Spotter roles. 
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Camera grids are enabled in playback panel controls settings: 

 

6.4 Image fit 
Image fit modes can be changed from the tab context menu: 

 
 

Or from a button at the playback panel: 

 
Image fit modes are the following: 

• Off 
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o Keep the image view scaling the same as the original image, and show the 
whole image at the view area. 

• Crop 

o Try to keep the image view scaling the same as the original image, fill all 
available view areas and cut part of the image off if needed. 

• Stretch 

o Change image scaling to stretch the whole image in the available view area. 

The image fit button is visible in the playback panel if it is enabled in the playback panel controls 
settings: 

 



Spotter Quick Start Guide  

Export – 35 

7 Export 

 

7.1 Export image 
1. Move the mouse cursor top of the image 

2. Click Export 
3. Select Export image 

 
 

1. Select the location 

2. Set name 

3. Select the format 

4. Click Export 

 
 

7.2 Add to video export 

7.2.1 The user can create a media clip with the Spotter, which 
contains max. 8 cameras 

All devices, which are selected to Add to the video export area will be added to the media clip 

1. Open camera toolbar from needed camera 

2. Click Export 
3. Select Add to video export 
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1. Set media clip starting point using LEFT yellow bar 

2. Set media clip endpoint using RIGHT yellow bar 

3. The Middle area shows the total length of the media clip 

 
 

1. Select Start to video export 

 
 

1. Select the location 

2. Set name 

3. Select Format 

4. Enable all other needed options 

5. Click Export 

 
 

1. Click I agree. Export will continue 
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MediaExporter show exporting data process 

 
When MediaExporter has finalized the video export, the user can access the location folder by 
clicking Open folder and close 

 
The folder contains all necessary files and SpotterPlayer.exe 

 

7.2.2 Supported export formats 
• ASF 

• AVI 

• Matroska 

• MP4 

• SEF and SEF2 

The fastest export file format is SEF (Secure Export Format). It can be viewed 
with Spotter or SpotterPlayer. 

• SEF - video with subtitles audio, text data (authenticity protected format)   

• SEF2 - video with subtitles audio, text data (authenticity protected format)   

• ASF- video with subtitles  audio, text data (authenticity protected format)  
• AVI - video, audio 

• MP4 (new in version 9.x) - video with subtitles 

Using the SEF2 enables: 

• Protecting the video material with the password, 
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• Software side privacy zones in the export, 

• Blur faces(The blurring needs to be enabled for the camera to be included in the 
export.)  

• Mask moving objects(The blurring needs to be enabled for the camera to be included in 
the export.)  

7.3 Add to storyboard 
An essential feature of any video management system is creating authentic video export 
material for law enforcement authorities. 

 
With Storyboard, it is possible to create a movie-like video export that makes it extremely easy 
for the recipient of the clip to view and understand instantly and accurately the chain of 
events. Storyboards can be viewed with the regular Spotter client application or the separate, 
standalone SpotterPlayer executable that is now exported as the default player for exported 
video. 

Storyboard allows, for example, the following: 

• I am creating a movie-like viewing experience from surveillance video material. 

• Maintains complete material authenticity. 

• View material in the Storyboard in sequential playback mode or an all-cameras real-
time mode. 

• Add clarifying comments and descriptions to activities. 

• Viewer for control of displaying of comments as subtitles. 

• Playback in continuous replay mode. 

• Save drafts and share the Storyboard with other system users. 

In addition to these, powerful features in the Spotter time slider make editing export clips very 
easy.  
These are explained in the section.A single Storyboard can contain a maximum of 63 camera 
streams. 

7.3.1 Adding Clips to Storyboard 
A storyboard is constructed from individual clips.These clips can contain up to 8 cameras, but 
for the most "movie like" experience, it is preferable to use a single camera per clip.The 
recommended way to start storyboard creation is to find the camera and event that will be the 
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first clip in the storyboard and adjust the first clip export start and end times usually with the 
export mode activity panel. 

 
After this, add the clip to the storyboard with the "Add clip to storyboard" button. 

 
This adds the clip as the first clip. 

 
The clip is still in edit mode (white text boxes and the "Save" icon).The clip name or description 
can be edited. Any change in the clip start or end times or camera content is still reflected in the 
clip contents.If no editing is needed, press the "Save" button. 

 
Now the clip is saved (texts change to non-white), and the following clip can be added to the 
storyboard. 

 
The most convenient way to add the following clip is to find the camera, open it to the work 
area, and drag it below the first clip in the storyboard.  

 
This will set the next clip start time to match the end time of the previous clip and copy the clip 
duration.The clip opens in edit mode, and the start and end times can be fine-tuned. 

 
The clips are highlighted in the activity panel. Note that it is all right if the clips overlap. 
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This same process can be repeated to add more clips to the storyboard. When it becomes 
difficult to drop a new camera to the list, the recommended way is to drop the new camera to 
the scroll bar.This will add the camera as the last clip. If a camera is dropped on top of an 
existing clip in the storyboard list, it will be added to that clip as an extra camera. 

There are other ways to add content to the storyboard: 

• With the camera toolbar export control. 

• By dragging and dropping from different search result screens and the device tree. 

• With a right-click option from the alarm list. 

7.3.2 Editing Clips In Storyboard 
Clips appear in the storyboard, always in time order, ordered by the clip's start time. A clip can 
be opened for editing later by pressing the "Edit" button. 

 
When a clip is opened for editing: 

• Any other clips in edit mode are automatically saved. 

• The name and description are editable and changed to white to indicate this. 

• The export time slider is populated with the devices from the clip. 

• The start and end times are editable and can be adjusted. 

• Devices can be added to the export time slider, and saving the clip will add them to the 
storyboard. 

If someone has created a bookmark for the clip time that is not already in the clip, editing the 
clip and saving the clip will add the bookmark to the storyboard.If the start time is adjusted so 
that it is now earlier than before and before another clip, the clips are rearranged in the 
storyboard list automatically.The start and end times of the clips can overlap. The start time of a 
later clip can be earlier than the end time of the previous clip.The user has several options for 
playback, but in the default setting, the clips are played sequentially, the first one to the end 
before the next one starts, even if the clip times overlap.The overlapping times are indicated in 
the time slider by a slight difference in the colour of the clips where they overlap. 

 
Please note that if the storyboard is long, the clips can be minimized with the click of the clip 
title. 

7.3.3 Descriptions And Comments 
The storyboard has several types of descriptions: 

• Whole storyboard description 
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• Individual clip descriptions 

• Bookmarks 

 
 

The descriptions are shown to viewers of the storyboard as subtitles.The timing of showing the 
descriptions is based on the start time of the clip or bookmark.Description texts are also 
exported in HTML text format to the target folder for further use for the target audience. 

7.3.4 Preview 
During the construction of a storyboard, it is possible to preview the storyboard by pressing the 
"Preview" button.This opens a new Spotter window where the draft storyboard can be 
previewed.After previewing, it is recommended to close the window and make any desired 
adjustments to the storyboard in the original Spotter window. 

 
Preview opens in a unique Spotter window, first to full screen, but the window can also be 
resized.  

7.3.5 Drafts And Sharing 
It is possible to save storyboard drafts by pressing the "Save draft…" button. 

This will open a dialogue where the user can enter a name for the draft storyboard. If there are 
many users interested in draft storyboards, it is recommended to save the storyboard to a 
shared location, such as a network drive. Then the draft storyboards can be opened by anyone 
who has access to the same profile used to generate the storyboard draft. The location can be 
defined in settings. The "Load draft" button can be used to load a draft storyboard.  
Please note that closing the Spotter window or exiting Spotter will clear any unfinished and 
unsaved storyboard contents. 

 

7.3.6 Settings 
Settings for the storyboard are described in Storyboard Settings. 

7.3.7 Exporting Storyboards 

 
When the storyboard is ready to be exported, the user can press the "Start Export" button. This 
will open a dialogue where the location and name can be adjusted.If no information is given, a 
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default location and default name will be used. Please note that large storyboards can take 
some time to export. It is also possible to export the individual video clips from the time slider 
button.The SpotterPlayer application will also be exported to the target folder if it is not already 
there. In addition to the media, the HTML text attachment with a summary and details of the 
storyboard is also exported to the target folder. 

7.3.8 Viewing Storyboards 
A storyboard can be viewed with Spotter or with the SpotterPlayer.Media can be opened by 
pressing the F4 key or by "Open media" from the File menu or by double-clicking the storyboard 
file in the file system. 

 
Then the storyboard can be opened from the file selection dialogue 

 
Media opens in "Media view" mode with a green window title. 

 
The clip will default open with the comment subtitles on and the player in "Repeat" mode. The 
individual clips are seen in the device tree area. 

 
The repeat and subtitle settings and the playtime settings can be changed from the buttons next 
to the playback controls.  
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7.3.9 Other Viewing Modes 

 
The sequential mode is the default playback mode. It plays the clips in time order, ordered by 
the start time of the clip. It plays each clip entirely before moving to the next so that the time can 
jump backwards in this mode.The user can switch the playback mode at any time. If he 
switches to "Playback all" mode, all cameras in the storyboard are opened.Note that when the 
user starts to play in this mode, the time does not jump backwards when clips overlap, but the 
storyboard is played in real-time. In the manual mode, no camera is opened or closed 
automatically, and the user can choose which camera to open from the device tree. 

7.4 Create Archive 

 
The archive is a tool for material backup and copying a larger amount of the material from 
multiple cameras. 
Archived material can be opened with the Spotter or SpotterPlayer 

Archive creation is only allowed if the archiving feature is enabled in the license. 

1. Set name of the archive 

2. Set password protection, if needed 

3. Set the location 

4. Set length of the archive 

5. Select archived components 

6. Click Create 

 
 

When the archive is done, you will see a notification in the UI upper right corner. 
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7.5 Open Media 
Archives or video clips are opened by the F4 key or the File menu “Open Media” option. 

 
1. Click Open Media 

2. Browse the location of the clip or archive 

 
 

3. Select archive file or clip(SEF) 

7.6 Authenticity verification 
The material authenticity is automatically verified when exported format SEF, SEF2, and ASF 
are played with the Spotter Player or Spotter. 

If the media is authentic, then the Spotter Player and Spotter are shown a notification: Media 
file authenticity is verified 

 
If the media is not authentic, then the Spotter Player and Spotter are shown a 
notification: Media file is not authentic 

 


